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KATA PENGANTAR  

  

Puji syukur kehadirat Allah SWT karena atas berkat rahmat-Nya yang telah 

dilimpahkan kepada penulis, sehingga Modul Riset Operasional 2 ini telah 

berhasil kami selesaikan sehingga dapat disajikan pada mahasiswa/i dan dapat 

menjadi sumber ilmu yang dapat dipahami oleh mahasiwa/i ataupun 

pembacanya.  

Riset operasional merupakan cabang interdisiplin dari matematika terapan 

dan sains formal yang menggunakan model-model seperti model matematika, 

statistika, dan algoritma untuk mendapatkan nilai optimal atau nyaris optimal 

pada sebuah masalah yang kompleks. Riset Operasional merupakan suatu 

metode/teknik/peralatan/cara manajemen yang digunakan oleh seorang manajer 

untuk menyelesaikan masalah-masalah yang sering muncul dalam kegiatan 

seharihari. Riset operasional biasanya digunakan untuk mencari nilai  maksimal  

(profit,  performa lini perakitan, hasil panen, bandwidth, dll) atau nilai minimal  

(kerugian,  risiko, biaya, dll) dari sebuah fungsi objektif. Sehingga akhirnya 

permasalahan tersebut dapat dipecahkan secara optimal.  

Untuk memudahkan penyelesaian masalah yang ada, modul ini juga 

dilengkapi dengan cara penggunaan aplikasi Win Quantitative System for 

Business (WinQSB) sebagai software yang digunakan untuk mengurangi 

kesalahan perhitungan secara manual.  

Akhir kata, semoga modul praktikum ini dapat memberikan manfaat bagi 

pembaca. Kritik dan saran sangat kami harapkan demi pengembangan modul ini 

di masa yang akan datang.  

 

 

Depok, Maret 2024  

  

  

    Tim Penyusun  
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BAB I   

TEORI ANTRIAN  

  

Deskripsi Modul  

Teori antrian adalah teori-teori yang menyangkut studi matematis dari barisan 

atau barisan pengguna. Antrian ini terjadi apabila kebutuhan akan suatu pelayanan 

melebihi kapasitas yang tersedia untuk menyelenggarakan pelayanan itu, sehingga 

pelanggan (customer) yang datang tidak segera mendapatkan pelayanan. Dalam 

kehidupan sehari-hari kejadian ini sering ditemukan. Misalnya seperti terjadi pada 

loket pembayaran, loket bioskop, loket kereta api, loket teller bank, pada dermaga 

pelabuhan, telepon jarak jauh, tempat praktek dokter, pompa minyak, pada 

pelanggan restoran yang menunggu pesanan, kedatangan pesanan barang di 

gudang, dan lain-lain.   

  

Tujuan Modul  

Setelah menyelesaikan praktikum pada modul ini, praktikan akan memahami:  

1) Konsep dalam menentukan Model Keputusan Antrian.  

2) Jenis-jenis biaya yang timbul dari sistem antrian.  

3) Pengaplikasian model-model antrian.  

  

Penjelasan Materi  

1.1 Sejarah Teori Antrian  

Teori antrian pertama kali dikemukankan oleh A. K. Erlang, seorang ahli 

matematika bangsa Denmark pada tahun 1913 dalam bukunya Solution of Some 

Problemin the Theory of Probability of Significance in Automatic Telephone 

Exchange. Saat ini teori antrian banyak diterapkan dalam bidang bisnis (bank, 

supermarket), industri (pelayanan mesin otomatis, penyimpanan), transportasi 

(pelabuhan udara, pelabuhan laut, jasa-jasa pos) dan masih banyak masalah 

sehari-hari yang lain.   
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Analisis antrian memberikan informasi probabilitas yang dinamakan 

operation characteristics,  yang  dapat  membantu  pengambil keputusan dalam 

merancang fasilitas pelayanan antrian untuk mengatasi permintaan pelayanan 

yang fluktuatif secara random dan menjaga keseimbangan antara biaya pelayanan 

dan biaya menunggu.  

 

Contoh masalah antrian yang kita temui sehari-hari:  

1) Pada waktu membayar karcis tol dalam perjalanan ke kantor.  

2) Mengambil uang di bank.  

3) Berbelanja di pasar swalayan.  

4) Membeli karcis kereta api.  

5) Memasuki stadion sewaktu menonton pertandingan olahraga.  

  

1.2 Tujuan Antrian  

Merancang fasilitas pelayanan untuk mengatasi permintaan pelayanan yang 

berfluktuasi secara random dan menjaga keseimbangan antara biaya (waktu 

nganggur) pelayanan dan biaya (waktu) yang diperlukan selama antri.  

  

1.3 Elemen Sistem Antrian  

Elemen sistem antrian merupakan komponen yang merupakan bagian atau 

anggota dari sistem antrian, yaitu:  

1. Pelanggan   

Pelanggan adalah orang atau barang yang menunggu untuk dilayani.  

2. Pelayan  

Pelayan adalah orang atau sesuatu yang memberikan pelayanan.  

3. Antrian   

Antrian merupakan kumpulan pelanggan yang menunggu untuk dilayani.  
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1.4 Karakteristik Antrian  

Karakteristik yang dapat dilihat dari suatu sistem antrian antara lain:   

1. Distribusi kedatangan (kedatangan tunggal atau kelompok).   

Distribusi kedatangan dari pelanggan dapat dilihat dari waktu antar 

kedatangan 2 pelanggan yang berurutan (interarrival time).  

2. Distribusi waktu pelayanan (pelayanan tunggal atau kelompok).   

Distribusi pelayanan dapat bersifat deterministik maupun stokastik. Waktu 

pelayanan yang sifatnya tetap disebut deterministik. Sedangkan yang tidak 

tetap atau acak disebut stokastik.    

3. Rancangan sarana pelayanan (stasiun serial, paralel atau jaringan).   

Pada rancangan sarana pelayanan ini, didalamnya termasuk juga jumlah 

server (pelanggan) yang dimiliki oleh sistem pelayanan.    

4. Peraturan pelayanan dan prioritas pelayanan.    

Peraturan yang dimaksud adalah prosedur yang dapat digunakan oleh para 

pelayan untuk memutuskan urutan pelanggan yang dilayani dari antrian.   

5. Ukuran antrian (terhingga atau tidak terhingga).   

Ukuran antrian artinya jumlah maksimum pelanggan yang diizinkan 

berada dalam sistem pelayanan (dalam antrian dan dalam pelayanan).   

6. Sumber pemanggilan (terhingga atau tidak terhingga).   

Ukuran sumber pemanggilan merupakan ukuran populasi yang potensial 

untuk menjadi pelanggan (calling population).   

7. Perilaku manusia (perpindahan, penolakan, atau pembatalan).   

  

1.5 Struktur Antrian  

Ada 4 model struktur antrian dasar yang umum terjadi dalam seluruh sistem 

antrian:  

1. Single Channel – Single Phase  

Single Channel berarti hanya ada satu jalur yang memasuki sistem 

pelayanan atau ada satu fasilitas pelayanan. Single Phase berarti hanya ada 

satu pelayanan.  
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2. Single Channel – Multi Phase  

Istilah Multi Phase menunjukkan ada dua atau lebih pelayanan yang 

dilaksanakan secara berurutan (dalam phasephase). Sebagai contoh: 

pencucian mobil.  

 

  

3. Multi Channel – Single Phase  

Sistem Multi Channel – Single Phase terjadi kapan saja dimana ada dua 

atau lebih fasilitas pelayanan dialiri oleh antrian tunggal, sebagai contoh 

model ini adalah antrian pada teller sebuah bank.  

 

  

4. Multi Channel – Multi Phase  

Sistem Multi Channel – Multi Phase ini mempunyai beberapa fasilitas 

pelayanan pada setiap tahapnya sehingga lebih dari satu individu dapat 

dilayani pada suatu waktu. Sebagai contoh, herregistrasi para mahasiswa 

di universitas, pelayanan kepada pasien di rumah sakit mulai dari 

pendaftaran, diagnosa, penyembuhan sampai pembayaran.  
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1.6 Aturan Teori Antrian  

Ada 5 macam disiplin antrian:  

1. FIFO (First In First Out) / FCFS (First Come First Served): Pelayanan 

disesuaikan dengan urutan kedatangan, individu yang pertama datang, 

maka akan dilayani terlebih dahulu.   

2. LIFO (Last In First Out) / LCFS (Last Come First Served): Individu yang 

terakhir datang, akan dilayani terlebih dahulu (berupa tumpukan).  

3. SIRO (Service In Random Order): Pelayanan dilakukan secara random 

atau acak. Contoh: pelayanan di toko yang tidak punya jalur antrian.  

4. SOT (Shortest Operating Time) / SPT (Shortest Processing Time): 

Pelayanan yang membutuhkan waktu paling cepat akan dilayani dahulu.   

5. PR (Priority): Mendahulukan pelayanan pada individu dengan prioritas 

tertentu.   

  

1.7 Model-Model Antrian  

Dalam mengelompokan model-model antrian yang berbeda-beda akan 

digunakan suatu notasi yang disebut kendall’s notation. Notasi ini sering 

dipergunakan karena beberapa alasan.  

Pertama, karena notasi tersebut merupakan alat yang efesien untuk 

mengidentifikasi tidak hanya model-model antrian, tapi juga asumsi-asumsi yang 

harus dipenuhi.  
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Dibawah ini adalah model-model yang digunakan dalam antrian:  

a) M/M/1/I/I   

b) M/M/S/I/I   

c) M/M/1/I/F   

d) M/M/S/F/I   

Penjelasan notasi-notasi pada model-model diatas:   

➢ Tanda pertama notasi selalu menunjukkan distribusi tingkat kedatangan. Dalam 

hal ini, M menunjukkan tingkat kedatangan mengikuti suatu distribusi 

probabilitas poisson.   

➢ Tanda kedua menunjukkan distribusi tingkat pelayanan. Lagi, M menunjukkan 

bahwa tingkat pelayanan mengikuti distribusi probabilitas poisson.   

➢ Tanda ketiga menunjukkan jumlah fasilitas pelayanan (channels) dalam system. 

Model diatas adalah model yang mempunyai fasilitas pelayanan tunggal.   

  

1.8 Aplikasi Model Antrian  

1. Tingkat kegunaan (Utility / U)  

   

2. Jumlah individu rata-rata dalam sistem ( L )  

   

3. Jumlah individu rata-rata dalam antrian ( Lq )  

     

4. Waktu rata-rata dalam sistem ( W )  

   

5. Waktu rata-rata dalam antrian ( Wq )  
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6. Probabilitas jumlah individu dalam sistem Untuk pelanggan ke- …  

   

Untuk adanya … Pelanggan  

     

Keterangan:   

λ : Tingkat kedatangan rata-rata (unit/jam)  

1/ λ : Waktu antar kedatangan rata-rata (jam/unit) 

μ : Tingkat pelayanan rata-rata (unit/jam)   

1/ μ : Waktu pelayanan rata-rata (jam/unit)  

Lq : Jumlah individu rata-rata dalam antrian (unit)   

L : Jumlah individu rata-rata dalam system (unit)  

Wq : Waktu rata-rata dalam antrian (jam)   

W : Waktu rata-rata dalam system (jam)  

Pn : Probabilitas jumlah n individu dalam system (frekuensi relatif)   

P : Tingkat kegunaan fasilitas pelayanan (rasio)  

  

Contoh Soal  

Tingkat kedatangan pelanggan pada “AXISMART” adalah 10 orang/15menit, 

sedangkan pelayanannya memerlukan waktu rata-rata 50 orang/jam. Bila tingkat 

kedatangan pelanggan mengikuti distribusi poisson dan tingkat pelayanan 

mengikuti distribusi eksponensial, maka tentukan:  

a. Tingkat kegunaan bagian pelayanan  

b. Jumlah pelanggan rata-rata dalam system   

c. Jumlah pelanggan rata-rata dalam antrian   

d. Waktu rata-rata dalam antrian   

e. Waktu rata-rata dalam system   

f. Probabilitas adanya pelanggan ke-20 dalam system   

g. Probabilitas untuk adanya 3 pelanggan dalam system   
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Jawaban  

     

     

   

  

a. Tingkat kegunaan  

   

   

Bahwa AXISMART akan sibuk melayani pelanggan selama 80% dari 

waktunya, sedangkan 20% dari waktunya (1-p) menganggur.  

b. Jumlah pelanggan rata-rata dalam system   

   

   

   

Angka 4 menunjukkan bahwa pegawai dapat mengharapkan 4 pelanggan yang 

berada dalam system.  

c. Jumlah pelanggan rata-rata dalam antrian   

   

        

Jadi, pelanggan yang menunggu untuk dilayani dalam antrian sebanyak 3 

pelanggan.  

d. Waktu rata-rata dalam antrian  

   

        

Jadi, waktu rata-rata pelanggan menunggu dalam antrian selama 4,8 menit.  
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e. Waktu rata-rata dalam system   

   

   

Jadi, waktu rata-rata pelanggan menunggu dalam system selama 6 menit.  

  

f. Probabilitas adanya pelanggan ke-20 dalam system  

   

   

   

Jadi, probabilitas adanya pelanggan ke-20 dalam system adalah 0,002306.  

  

g. Probabilitas untuk adanya 3 pelanggan dalam system   

   

   

   

   

   

   

   

   

         

   

        

     Jadi, probabilitas adanya 3 pelanggan dalam system adalah 0,5904.  
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Penggunaan Software  

1. Start -> all program -> WinQSB  

2. Pilih Queuing Analysis  

  

3. Tampilan awal saat program dijalankan  

 

4. Untuk memulai, pilih menu File -> New Problem  
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5. Pada form Problem Specification, masukkan:  

• Problem Title = AXISMART (disesuaikan dengan soal)  

• Time unit (satuan yang digunakan) = hour  

• Pilih Simple M/M System pada Entry Format  

• Klik OK untuk melanjutkan  

  

  

6. Masukkan:  

• Number of server = 1   

• Costumer arrival rate (lambda) = 40  

• Service rate (μ) = 50  

• Isikan Queue Capacity = M (menandakan kapasitas Antrian tidak terbatas 

<infinity>)  

• Costumer Population = M (menandakan banyaknya pelanggan tidak 

terbatas <infinity>)  
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7. Untuk melakukan problem solving, pilih menu Solve and Analyze  -> Solve 

the Performance  

  

  

8. Hasil akhir dari problem solving:  

• Tingkat Kegunaan (U) Overall system utilization = 80,00% (0,80)  

• Jumlah Pelanggan Rata-rata Dalam Sistem (L) = 4  

• Jumlah Pelanggan Rata-rata Dalam Antrian (Lq) = 3,2 • Waktu Rata-rata 

Dalam Sistem (W) = 0,1000 hours  

• Waktu Rata-rata Dalam Antrian (Wq) = 0,0800 hours   

• Kemungkinan Semua Loket Menganggur (P0) = 20% (0,20)   

• Kemungkinan Kedatangan Pelanggan Menunggu (Pw) = 80% (0,80)   
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9. Untuk menghitung probabilitas adanya pelanggan ke-20 dalam system. Pilih 

menu Result -> Probability Summary.  

  

10. Hasil perhitungan kemungkinan adanya pelanggan ke-20, pada kolom 

Estimated Probability of n Costumers in the System cari n ke-20. Itulah 

kemungkinan adanya pelanggan ke-20 yaitu sebesar 0,0023.   

 
 

11. Untuk menghitung adanya 3 pelanggan dalam sistem perhatikan kolom 

Cumulative Probability. Cari n ke yaitu sebesar 0,5904.  
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Latihan Soal  

1. Tingkat kedatangan pelanggan pada DM Cake’s adalah 56 orang/jam, 

sedangkan pelayanannya memerlukan waktu rata-rata 80 orang/jam. Bila 

tingkat kedatangan pelanggan mengikuti distribusi poisson dan tingkat 

pelayanan mengikuti distribusi eksponensial, maka tentukan:  

a. Tingkat kegunaan bagian pelayanan  

b. Jumlah pelanggan rata-rata dalam system   

c. Jumlah pelanggan rata-rata dalam antrian  

d. Waktu rata-rata dalam antrian  

e. Waktu rata-rata dalam system  

f. Probabilitas adanya pelanggan ke-15 dalam system  

g. Probabilitas untuk adanya 4 pelanggan dalam system  

  

2. Tingkat kedatangan pelanggan pada Café Berlin adalah 60 orang/jam, 

sedangkan pelayanannya memerlukan waktu rata-rata 80 orang/jam. Bila 

tingkat kedatangan pelanggan mengikuti distribusi poisson dan tingkat 

pelayanan mengikuti distribusi eksponensial, maka tentukan:  

a. Tingkat kegunaan bagian pelayanan  

b. Jumlah pelanggan rata-rata dalam system   

c. Jumlah pelanggan rata-rata dalam antrian  

d. Waktu rata-rata dalam antrian  

e. Waktu rata-rata dalam system  

f. Probabilitas adanya pelanggan ke-20 dalam system  

g. Probabilitas untuk adanya 3 pelanggan dalam system  
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3. Tingkat kedatangan pengunjung pada Festival Musik adalah 30 orang/jam, 

sedangkan pelayanannya memerlukan waktu rata-rata 60 orang/jam. Bila 

tingkat kedatangan pelanggan mengikuti distribusi poisson dan tingkat 

pelayanan mengikuti distribusi eksponensial, maka tentukan:  

a. Tingkat kegunaan bagian pelayanan  

b. Jumlah pelanggan rata-rata dalam system   

c. Jumlah pelanggan rata-rata dalam antrian  

d. Waktu rata-rata dalam antrian  

e. Waktu rata-rata dalam system  

f. Probabilitas adanya pelanggan ke-10 dalam system  

g. Probabilitas untuk adanya 5 pelanggan dalam system  
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BAB II  

PROGRAM EVALUATION AND REVIEW TECHNIQUE  

  

Deskripsi Modul  

PERT menjelaskan tentang pembuatan network yang berisi tentang 

pemahaman komponen-komponen, analisa network dan hal yang perlu 

diperhatikan dalam analisa network, serta distribusi probabilitas beta sehingga 

dapat melakukan penjadwalan setiap kegiatan-kegiatan.  

  

Tujuan Modul  

Setelah menyelesaikan praktikum pada modul ini, praktikan akan memahami:  

1. Komponen-komponen utama untuk membuat jaringan  

2. Hal-hal yang perlu diperhatikan dalam pembuatan jaringan  

3. Asumsi-asumsi yang digunakan dalam PERT  

4. Dapat melakukan penjadwalan kegiatan  

  

Penjelasan Materi  

2.1 Pendahuluan  

Konsep network ini mula–mula disusun oleh perusahaan jasa konsultan 

manajemen Boaz, Allen, dan Hamilton yang disusun untuk perusahaan pesawat 

terbang Lockheed. Kebutuhan penyusunan network ini dirasakan karena perlu 

adanya koordinasi dan pengurutan kegiatan-kegiatan pabrik yang kompleks, yang 

saling berhubungan dan saling bergantung satu sama lain. Hal ini dilakukan agar 

perencanaan dan pengawasan semua kegiatan itu dapat dilakukan secara 

sistematis, sehingga dapat diperoleh efisiensi kerja.  

Masalah penjadwalan, perencanaan, dan pengawasan suatu proyek dari segi 

waktu biasanya dianalisis dengan salah satu model jaringan yang  dinamakan  

Critical Path Method (CPM) atau Program Evaluation and Review Technique 

(PERT). CPM dan PERT pada dasarnya serupa, bedanya CPM adalah teknik 

deterministic, sedangkan PERT bersifat probabilistik. Pada teknik deterministik, 
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waktu kegiatan diasumsikan diketahui dengan pasti sehingga merupakan nilai   

tunggal, sedangkan pada PERT waktu kegiatan merupakan variabel random yang 

memiliki distribusi probabilistik.  

Salah satu tujuan dari analisis CPM atau PERT adalah untuk menentukan 

waktu terpendek yang diperlukan untuk merampung proyek atau menentukan 

critical path, yaitu jalur dalam jaringan yang membutuhkan waktu penyelesaian 

paling lama. Kegiatan-kegiatan yang dilewati critical path dinamakan kegiatan 

kritis. Keterlambatan penyelesaian salah satu kegiatan ini akan menyebabkan 

keterlambatan penyelesaian proyek.  

  

2.2 Pengertian PERT  

Menurut Heizer dan Render (2014:101), PERT merupakan teknik manajemen 

proyek yang meggunakan tiga perkiraan waktu untuk setiap aktivitas. PERT dapat 

membantu para manajer melakukan penjadwalan, pemantauan, serta pengendalian 

proyek-proyek besar dan kompleks.  

Menurut Levin dan Kirkpatrick (1977:11), PERT merupakan suatu metode 

yang bertujuan sebanyak mungkin mengurangi adanya penundaan maupun 

gangguan dan konflik produksi; mengkoordinasikan dan mensinkronisasikan 

berbagai bagian sebagai suatu keseluruhan pekerjaan; dan mempercepat 

selesainya proyek.  

  

2.3 Pembuatan Network  

Model Jaringan tersusun atas beberapa komponen utama:  

1. Kegiatan  (activity) adalah suatu pekerjaan atau tugas dimana  

penyelesaiannya memerlukan periode waktu, biaya, serta fasilitas tertentu. 

Biasanya diberi simbol anak panah.  

2. Peristiwa (event), yaitu permulaan atau akhir suatu kegiatan. Biasanya 

peristiwa digambarkan dengan suatu lingkaran atau nodes.  

3. Kegiatan semu (dummy), yaitu kegiatan yang tidak nyata. Suatu dummy 

activity tidak memakan waktu dan sumber daya. Jadi, waktu kegiatan dan 

biaya sama dengan nol.  
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         Sebagai contoh yang menunjukan hubungan antara events dengan activities 

ini adalah pekerjaan mengecat pintu. Event pertama adalah pintu masih kotor 

belum dicat, kemudian dilakukan kegiatan pengecatan, dan akhirnya setelah 

kegiatan pengecatan selesai kita peroleh event kedua, yaitu pintu telah di cat.  

Untuk lebih jelasnya, contoh ini dapat dilihat pada gambar 2.1 berikut:  

  

 

Adapun, kegunaan dari kegiatan semu antara lain:  

         Untuk menghindari terjadinya dua kejadian yang dihubungkan oleh lebih  

dari  satu kegiatan. Dengan asumsi sebelumnya yang dikatakan bahwa network 

hanya dimulai dari satu kejadian awal yang sebelumnya tidak ada pekerjaan yang   

mendahuluinya, terkadang harus ditambahkan satu kejadian semu pada awal  

suatu network, satu kejadian semu pada akhir network, dan kegiatan-kegiatan 

semu yang menghubungkan kejadian awal atau akhir dengan kejadian-kejadian  

di dalam network apabila network dimulai atau diakhiri oleh beberapa kejadian. 

Kegunaan dummy activities itu untuk menunjjukan urut-urutan pekerjaan secara 

tepat.  

  

2.4 Hal yang Harus Diperhatikan dalam Analisa Network  

Untuk bisa melakukan analisa network, kita harus memperhatikan hal-hal 

berikut:  

1. Sebelum suatu kegiatan dimulai, semua kegiatan yang mendahuluinya  

harus selesai dikerjakan.  

2. Gambar anak panah hanya sekedar menunjukan urutan-urutan di dalam 

mengerjakan pekerjaan saja. Panjang anak panah dan arahnya tidak 

menunjukan letak dari pekerjaan.  
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3. Nodes (lingkaran yang menunjukan kejadian) diberi nomor sedemikian 

rupa sehingga tidak terdapat nodes yang  mempunyai nomor sama. Untuk 

menghindari arah anak panah yang berulang kembali (lihat gambar 2.2a), 

biasanya nomor yang lebih kecil diletakan pada awal anak panah, 

sedangkan pada akhir anak panah diberi nomor lebih besar (lihat gambar 

2.2b).  

 
  Gambar 2.2a                                          Gambar 2.2b                     

4. Dua buah kejadian (events) hanya bisa dihubungkan oleh satu kegiatan 

(anak panah).  

5. Network hanya dimulai dari satu kejadian awal (initial event) yang 

sebelumnya tidak ada pekerjaan yang mendahuluinya. Disamping itu, 

network diakhiri oleh satu kejadian saja (terminal event).  

  

2.5 Distribusi Probabilitas Beta  

Seringkali waktu penyelesaian kegiatan tidak diketahui dengan pasti atau 

merupakan variabel acak (random), maka diperlukan asumsi tertentu tentang 

bentuk distribusi waktu penyelesaian kegiatan. Bentuk probabilistik waktu 

penyelesaian kegiatan tersebut dapat menggunakan distribusi beta.  

Setiap kegiatan diasumsikan memberikan tiga kemungkinan waktu 

penyelesaian, yaitu:  

1. Optimistic time (a) ialah waktu terpendek untuk menyelesaikan kegiatan. 

Probabilitas waktu penyelesaian lebih pendek dan waktu ini sangat kecil.  

2. Most likely time (m) ialah waktu yang paling mungkin untuk 

menyelesaikan kegiatan.  

3. Pessimistic time (b) ialah waktu terlama untuk menyelesaikan kegiatan.  

Probabilitas waktu penyelesaian lebih panjang dari waktu ini sangat kecil.  
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PERT mengasumsikan bahwa penyelesaian kegiatan mengikuti distribusi 

beta dengan rata-rata (tij) dan varian (vij) seperti berikut:  

 

PERT juga mengasumsikan bahwa waktu kegiatan adalah independen  secara 

statistic sehingga rata-rata dan varian waktu-waktu kegiatan itu dapat 

dijumlahkan untuk menghasilkan rata-rata dan varian waktu penyelesaian proyek. 

PERT juga mengasumsikan bahwa rata-rata dan varian waktu penyelesaian 

proyek mengikuti distribusi normal.  

  

2.6 Penjadwalan Kegiatan  

Analisis PERT juga bertujuan menentukan jadwal kegiatan yang dapat 

menerangkan kapan kegiatan ini dimulai dan berakhir. Penjadwalan itu juga dapat 

menentukan critical path (sekaligus waktu minimum yang diperlukan  untuk 

menyelesaikan proyek dan kegiatan apa saja yang dapat ditunda dan berapa lama).  

1. Earliest Time (ET): Waktu minimum yang diperlukan untuk 

menyelesaikan proyek. 

 

 

2. Latest Time (LT): Waktu terakhir (paling lama) suatu event dapat 

direalisasikan tanpa menunda waktu penyelesaian proyek.  

 

 

3. Slack Kegiatan (S): Waktu   dimana   suatu   kegiatan   dapat   ditunda 

tanpa mempengaruhi penyelesaian proyek dengan waktu minimum atau 

waktu longgar aktivitas, yang sama dengan (LT – ET).  

  

   t ij   =   

  

    vij   =   

Earliest Time (ETj) = Maks {ETj + tij} 

Latest Time (LTi) = Min {LTj – tij} 

(Sij) = LTj – Eti – tij 
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Contoh Soal  

Di bawah ini adalah waktu perbaikan jalan di Depok  

Kegiatan 
Kegiatan 

Sebelumnya      

A  -  9 10 11    

B  A  10 11 12    

C  A  10 12 14    

D  A  10 13 16    

E  B, C, D  12 15 18    

F  B, C, D  11 12 13    

G  E  12 14 16    

H  G  9 10 11    

I  F  10 11 12    

J  I  7 10 13    

K  H, J  10 13 16    

  

Berdasarkan data di atas tentukanlah:   

a. Gambarkan Jaringan!  

b. Tentukan Distribusi Beta!   

c. Tentukanlah Jalur Kritis!  

d. Tentukan Probabilitas proyek dikerjakan lebih dari 78 minggu!  
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Jawaban  

A. Gambar Jaringan  

 
 

B. Distribusi Beta  

 

   

A t12 = 10 v12 = 1/9 

B t23 = 11 v23 = 1/9 

C t24 = 12 v24 = 4/9 

D t25 = 13 v25 = 1 

E t56 = 15 v56 = 1 

F t57 = 12 v57 = 1/9 

G t68 = 14 v68 = 4/9 

H t810 = 10 v810 = 1/9 

I t79 = 11 v79 = 1/9 

J t910 = 10 v910 = 1 

K t1011 = 13 v1011 = 1 
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C. Penentuan Jalur Kritis  

       Dalam menentukan jalur kritis, kita harus mengetahui terlebih dahulu Earliest 

Time (ET) dan Latest Time (LT) dari masing peristiwa / event atau node yang 

terjadi. Lalu pilih peristiwa mana yang memiliki nilai ET dan LT yang sama, 

maka itulah jalur kritisnya.  

 

Berikut adalah langkah-langkah penjelasannya:  

1) Node 1 selalu memiliki nilai ET1 = 0 minggu  

 

2) Node 2 berasal dari kegiatan A (t12), maka nilai ET2 = ET1 + t12  

   = 0 + 10  

                          = 10 minggu  

  

  

 

3) Node 3 berasal dari kegiatan B (t13) maka, nilai ET3 = ET2 + t23  

    = 10 + 11 

    = 21 minggu 
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4) Node 4 berasal dari kegiatan C (t24) atau dummy 1  

        Maka nilai ET4 = ET3 + dummy 1  

                = 21 + 0 = 21 minggu  

        Maka nilai ET4 = ET2 + t24  

                 = 10 + 12 = 22 minggu  

  

 

5) Node 5 berasal dari kegiatan D (t25) atau dummy 2, maka nilai   

ET5 = ET2 + t25 = 10 + 13 = 23 minggu  

  

 

6) Begitu seterusnya sampai ET11  
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7) Selanjutnya tentukan LT. Menentukan LT dengan cara mundur dari node yang 

paling belakang sehingga dimulai dari node 11. Maka, LT11 = 75  

 

  

8) Node 10 penyebab dari kegiatan K, maka nilai LT10 = LT11 -  t1011  

                                 = 75 - 13 = 62  

  

9) Begitu seterusnya sampai LT1  

10) *Dalam menentukan LT, pilih yang memiliki nilai LT paling kecil, lalu pilih 

jalur kritis yang memiliki nilai ET dan LT yang sama.  
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Jadi, Jalur kritisnya adalah A-D-E-G-H-K  

a. Probabilitas Proyek Dikerjakan Lebih dari 78 Minggu  

µ = t12 + t25 + t56 + t68 + t810      

   = 10 + 13 + 15 + 14 +10 + 13  

   = 75  

 
= v12 + v25 + v56 + v68 + v810  

    =    

     =    

 

P (tij ≥ 78)  

P (tij ≥ 78)          = Pz   ≥    

                        = Pz   ≥    

  

 

P (tij ≥ 78)                   = Pz   ≥   

                    = Pz   ≥  1,56670 (dibulatkan menjadi 1,5)  

                                  = 0,5 – 0,4332  

                        = 0,0668  
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Penggunaan Software  

1. Start -> All Program -> WinQSB  

 

  

2. Pilih program PERT_CPM  

 

3. Tampilan awal PERT atau CPM  
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4. Pilih menu File -> New Problem untuk memulai  

  

5. Pada form Problem Specification isikan:  

• Problem title (isikan data Anda)  

• Number of Activities = 11  

• Time unit (satuan waktu) = week  

• Problem Type = Probabilistic PERT  

• Klik OK untuk melanjutkan  

  

6. Isikan tabel sesuai dengan soal  
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7. Pilih menu Solve and Analyze -> Solve Critical Path  

  

  

8. Hasil akhir  

  

  

9. Untuk melihat jalur kritisnya pilih menu Results -> Show Critical Path  

  

10. Untuk melihat jalur kritisnya pilih menu Results → Graphic Activity Analysis  
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Latihan Soal  

1. Dibawah ini adalah waktu perbaikan jalan Cileungsi : 

Kegiatan 
Kegiatan 

Sebelumnya      

A - 8 9 10     

B A 10 11 12     

C B 9 10 11     

D B 11 14 17     

E B 10 13 16     

F C 13 14 15     

G D, E 9 12 15     

H G 13 15 17     

I F 10 11 12     

J H 8 10 12     

K I, J 12 13 14     

Berdasarkan data di atas tentukanlah: 

a. Gambarkan Jaringan! 

b. Tentukan Distribusi Beta! 

c. Tentukanlah Jalur Kritis! 

d. Tentukan Probabilitas proyek dikerjakan lebih dari 85 minggu! 
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2. Dibawah ini adalah waktu pembuatan mall di Depok : 

Kegiatan 
Kegiatan 

Sebelumnya      

A - 8 10 12   

B - 11 12 19   

C A, B 6 9 12   

D C 12 15 18   

E C 9 13 17   

F D 12 14 16   

G E 9 10 11   

H F 10 11 12   

I G 10 12 14   

J H, I 8 15 22   

K J 12 16 20   

Berdasarkan data di atas tentukanlah: 

a. Gambarkan Jaringan! 

b. Tentukan Distribusi Beta! 

c. Tentukanlah Jalur Kritis! 

d. Tentukan Probabilitas proyek dikerjakan lebih dari 95 minggu! 
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3. Dibawah ini adalah waktu renovasi stadium GBK : 

Kegiatan 
Kegiatan 

Sebelumnya      

A - 10 12 14   

B - 8 10 12   

C A 12 14 16   

D C 9 10 11   

E C 14 16 18   

F B 10 13 16   

G F 8 9 10   

H D, E 12 13 14   

I G, H 10 15 20   

J I 11 12 13   

K J 8 10 12   

Berdasarkan data di atas tentukanlah: 

a. Gambarkan Jaringan! 

b. Tentukan Distribusi Beta! 

c. Tentukanlah Jalur Kritis! 

d. Tentukan Probabilitas proyek dikerjakan lebih dari 95 minggu! 
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BAB III   

TEORI ANTRIAN DALAM PRAKTEK  

 

Deskripsi Modul  

Antrian menjelaskan tentang tujuan dasar model antrian, elemen-elemen 

pokok dalam antrian, macam-macam struktur antrian serta asumsi-asumsi yang 

digunakan dalam mengunakan teori antrian khususnya asumsi yang digunakan 

dalam model antrian jenis multi channel single phase.  

  

Tujuan Modul  

Setelah menyelesaikan praktikum pada modul ini, praktikan akan memahami:  

1. Efektifitas suatu channel atau loket.  

2. Keputusan membangun channel atau loket.  

3. Pengidentifikasian efektifitas suatu loket.  

4. Kemungkinan atau probabilitas pelanggan.  

 

Penjelasan Materi  

3.1 Pendahuluan  

Sistem ekonomi dan usaha (bisnis) sebagian besar beroperasi dengan sumber 

daya yang relatif terbatas. Sering terjadi orang-orang, barang-barang, komponen-

komponen, atau kertas kerja harus menunggu untuk mendapatkan jasa pelayanan. 

Garis-garis tunggu ini sering disebut dengan antrian (Queues), berkembang 

karena kualitas pelayanan (server) adalah relatif mahal untuk memenuhi 

permintaan layanan dan sangat terbatas.  

 

3.2 Sistem Antrian  

Ada tiga komponen dalam sistem antrian, yaitu:  

1) Populasi dan cara kedatangan pelanggan datang ke dalam sistem.  

2) Sistem pelayanan.  

3) Kondisi pelanggan saat keluar sistem.  
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3.3 Populasi dan Cara Kedatangan  

1. Populasi  

Populasi yang akan dilayani (calling population). Setiap masalah antrian 

melibatkan kedatangan, misalnya orang, mobil, panggilan telepon untuk 

dilayani, dan lain–lain.  Unsur ini sering  dinamakan proses input.  Proses 

input meliputi sumber kedatangan atau biasa dinamakan calling population 

dan cara terjadinya kedatangan yang umumnya merupakan variabel acak. 

Menurut Levin, dkk (2002), variabel acak adalah suatu variabel yang nilainya 

bisa berapa saja sebagai hasil dari percobaan acak. Variabel acak dapat berupa 

diskrit atau kontinu. Bila variabel acak hanya dimungkinkan memiliki 

beberapa nilai saja, maka ia merupakan variabel acak diskrit. Sebaliknya bila 

nilainya dimungkinkan bervariasi pada rentang tertentu, ia dikenal sebagai 

variabel acak kontinu.  

Karakteristik dari populasi yang akan dilayani (calling population) dapat 

dilihat menurut ukurannya, pola kedatangan, serta perilaku dari populasi yang 

akan dilayani. Menurut ukurannya, populasi yang akan dilayani bisa terbatas 

(finite) bisa juga tidak terbatas (infinite). Sebagai contoh, jumlah mahasiswa 

yang antri untuk registrasi di sebuah perguruan tinggi sudah diketahui 

jumlahnya (finite), sedangkan jumlah nasabah bank yang antri untuk setor, 

menarik tabungan, maupun membuka rekening baru, bisa tak terbatas  

(infinte).  

 

2. Distribusi Kedatangan  

Secara umum, formula garis tunggu antrian memerlukan informasi tingkat 

kedatangan unit per periode waktu (arrival rate). Distribusi kedatangan bisa 

teratur - tetap dalam satu periode. Artinya kedatangan unit/pelanggan dalam 

antrian dengan unit/pelanggan berikutnya memiliki periode waktu yang sama.  

Kedatangan yang seperti ini biasanya hanya ada di sistem produksi dimana 

antrian dikendalikan oleh mesin. Kedatangan yang teratur sering kita jumpai 

pada proses pembuatan/pengemasan produk yang sudah distandardisasi.  
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Pada proses semacam ini, kedatangan produk untuk diproses pada bagian 

selanjutnya biasanya sudah ditentukan waktunya, misalnya setiap 30 detik.  

Pada banyak  kasus  dalam praktek,  kedatangan  unit/pelanggan  dalam  

antrian dengan unit/pelanggan berikutnya bersifat variabel atau acak 

(random). Kedatangan yang sifatnya acak (random) banyak kita jumpai 

misalnya kedatangan nasabah di bank.  Pola kedatangan yang  sifatnya  acak  

dapat  digambarkan  dengan  distribusi statistik dan dapat ditentukan dua cara 

yaitu:  

a. Dengan cara menganalisa kedatangan per satuan waktu untuk melihat 

apakah waktu kedatangan unit/pelanggan dalam antrian mengikuti pola  

distribusi statistik tertentu. Biasanya kita mengasumsikan  bahwa waktu  

kedatangan unit/pelanggan dalam antrian dengan unit/pelanggan 

berikutnya berdistribusi eksponensial.  

b. Dengan cara menetapkan lama waktu (T) dan mencoba menentukan 

berapa banyak unit/pelanggan yang datang ke dalam sistem dalam kurun 

waktu (T) secara spesifik. Biasanya diasumsikan bahwa jumlah 

kedatangan per satuan waktu mengikuti pola distribusi poisson. Suatu 

faktor yang mempengaruhi penilaian distribusi kedatangan adalah ukuran 

populasi panggilan. Contoh: jika seorang tukang reparasi sedang 

memperbaiki enam buah mesin, populasi panggilan dibatasi sampai 

dengan enam buah mesin. Dalam hal ini tidak mungkin  bahwa kedatangan 

mengikuti distribusi poisson sebab tingkat kecepatan kerusakan tidak 

konstan. Jika lima buah mesin telah rusak, tingkat kedatangan lebih rendah 

dari pada bila seluruh mesin dalam keadaan operasi. Populasi yang akan 

dilayani mempunyai perilaku yang berbeda-beda dalam membentuk 

antrian. Ada tiga jenis perilaku: reneging, balking, dan jockeying. 

Reneging menggambarkan situasi dimana seseorang  masuk dalam antrian, 

namun  belum  memperoleh  pelayanan, kemudian meninggalkan antrian 

tersebut. Balking menggambarkan orang yang tidak masuk dalam antrian 

dan langsung  meninggalkan  tempat  antrian. Jockeying  menggambarkan  

orang yang pindah-pindah antrian.  
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3. Pola Kedatangan  

Kedatangan unit/pelanggan dalam sistem antrian, untuk beberapa kasus, 

dapat dikendalikan. Misalnya kedatangan dikendalikan dengan cara 

memberikan potongan pada hari-hari tertentu yang sepi dengan maksud 

menggiring pelanggan untuk datang pada jam sepi, memberikan harga tinggi 

pada sesi-sesi padat agar pelanggan tergiring datang pada hari lain yang lebih 

murah. Namun demikian, dalam beberapa kasus yang lain, kedatangan  

unit/pelanggan  dalam  antrian  tidak  dapat  dikendalikan misalnya 

permintaan bantuan emergensi di rumah sakit, atau pemadam kebakaran atau 

kantor polisi.  

 

4. Jumlah Unit dan Pelanggan yang Datang  

Kedatangan tunggal atau dengan kata lain satu kali kedatangan bisa saja 

hanya terdiri dari satu unit atau satu pelanggan. Namun demikian bisa saja 

dalam satu kali kedatangan terdiri dari banyak unit yang disebut batch 

arrivals, misalnya kedatangan undangan di lima acara pesta di sebuah 

restoran.  

  

5. Tingkat Kesabaran  

Tingkat kesabaran pelanggan dalam antrian dikelompokkan menjadi dua, 

yakni:  

a. Kedatangan yang sabar. Yaitu seseorang yang bersedia menunggu hingga 

dilayani terlepas apakah mereka menunjukkan perilaku tidak sabar seperti 

menggerutu atau mengomel tetapi tetap menunggu dalam antrian.  

b. Kedatangan yang tidak sabar. Kedatangan yang tidak sabar dikelompokkan 

menjadi dua kategori. Kategori yang pertama adalah orang yang datang, 

melihat-lihat fasilitas layanan dan panjang antrian, lalu memutuskan 

meninggalkan sistem. Kategori yang kedua adalah orang yang datang, 

melihat fasilitas layanan, bergabung dalam antrian dan untuk beberapa 

lama kemudian meninggalkan sistem.  
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3.4 Struktur Antrian  

Proses antrian  pada  umumnya  dikelompokkan  ke  dalam  empat  struktur 

dasar menurut sifat-sifat fasilitas pelayanan, yaitu:  

1) Single Channel - Single Phase (satu saluran satu tahap)  

2) Single Channel - Multi Phase (satu saluran banyak tahap)  

3) Multi Channel - Single Phase (banyak saluran satu tahap)  

4) Multi Channel - Multi Phase (banyak saluran banyak tahap)  

Pada praktikum semester ini kalian telah mempelajari antrian single channel 

single phase pada Riset Operasional 2 Bab 1. Kini pada Bab 3 pembahasan 

antrian masih berlanjut tepatnya antrian MULTI CHANNEL SINGLE PHASE.  

  

Antrian Multi Channel Single Phase  

a) Asumsi-asumsi dalam multi channel single phase (infinite):  

1) Jumlah antrian tidak dibatasi.  

2) Kedatangan mengikuti distribusi poisson.  

3) Waktu pelayanan mengikuti distribusi exponential negative.  

4) First come, first served.  

5) Saluran dikalikan dengan tingkat pelayanan > dari tingkat kedatangan.  

  

b) Ciri ciri distribusi poisson:  

1) Tingkat kedatangan rata-rata dapat diduga berdasarkan data masa lalu.  

2) Tingkat kedatangan rata-rata persatuan waktu adalah konstan.  

3) Banyaknya kedatangan dalam suatu selang waktu tidak dipengaruhi apa 

yang terjadi pada selang waktu sebelumnya.  

4) Probabilitas suatu kedatangan dalam selang waktu yang sangat pendek 

adalah sangat kecil sehingga probabilitas > dari satu kedatangan dalam 

selang waktu yang pendek akan mendekati 0 (nol).  
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Multi channel single phase (infinite) = antrian tidak dibatasi  

  

 

Catatan : untuk yang diketahui c, dihitung dari 1, 2, 3, dst sampai ke-c.  

  

Probabilitas tidak adanya pengantri dalam system  

  

Probabilitas orang ke-n mengantri dalam system  

 
Tingkat Kegunaan  

  

Rata-rata banyaknya pengantri dalam antrian (Lq)  

 

Rata-rata banyaknya pengantri dalam System (L)  

  

Rata-rata waktu mengantri dalam antrian (Wq)  

  

Rata-rata waktu mengantri dalam System (W)  
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Contoh Soal  

Diketahui loket penjualan tiket final Proliga 2015 di Istora Senayan ada 3 buah 

dengan tingkat pelayanannya yaitu 50 orang/jam mengikuti distribusi poisson.  

Serta diketahui juga tingkat kegunaannya 70%. Maka tentukan:  

a. Tingkat Kedatangan  

b. Proporsi tidak adanya pengantri dalam system  

c. Rata-rata banyaknya pengantri dalam antrian  

d. Rata-rata banyaknya pengantri dalam system  

e. Rata-rata waktu mengantri dalam antrian   

f. Rata-rata waktu mengantri dalam system  

g. Probabilitas adanya orang ke-6  

  

Jawaban  

a.    

       = 0,7 x 3 x 50  

       = 105  

Jadi, tingkat kedatangan pelanggan pada final Proliga 2015 di Istora Senayan   

adalah 105 orang/jam.  

 

b.  

  

   

    

Jadi, probabilitas tidak adanya pengantri dalam sistem pada final Proliga 2015  

di Istora Senayan adalah 0,0957. 
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c.  

    

       

Jadi, rata-rata banyaknya pengantri dalam antrian pada final Proliga 2015 di 

Istora Senayan adalah sebanyak 1 orang.  

 

d.   

     

     

Jadi, rata-rata banyaknya pengantri dalam sistem final Proliga 2015 di Istora 

Senayan adalah sebanyak 3 orang.  

 

e.  

     

        

Jadi, rata-rata lamanya waktu menunggu untuk dilayani dalam antrian pada  

final Proliga 2015 di Istora Senayan selama 0,66 menit.  

 

f.  

      

 

Jadi, rata-rata lamanya waktu menunggu untuk dilayani dalam sistem pada 

final Proliga 2015 di Istora Senayan selama 1,854 menit.  
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g.  

  

         

Jadi, probabilitas adanya orang ke-6 yang mengantri dalam sistem pada final  

Proliga 2015 di Istora Senayan adalah 0,0507.  

  

 

Penggunaan Software  

1. Buka software WinQSB, pilih Queuing Analysis  

  

  

2. Pilih menu File -> New Problem untuk memulai  

   

3. Pada form Problem Specification:  

• Problem Title (isikan data anda)  

• Time Unit (satuan waktu) = hour  

• Klik OK untuk melanjutkan  
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4. Masukkan :  

• Number of Serves = 3  

• Service rate (per server per hour) μ = 50  

• Costumer arrival rate (per hour) λ = 105  

 

5. Pilih menu Solve and Analyze -> Solve the Performance  

   

6. Hasil problem solving :  

• Tingkat kegunaan = 70%  

• Proporsi waktu menganggur kasir (P0) = 9,5694  

• Rata-rata banyaknya pengantri dalam antrian (Lq) = 1,1488  

• Rata-rata banyaknya pengantri dalam system (L) = 3,2488  

• Rata-rata waktu menunggu dalam antrian (Wq) = 0,0109  

• Rata-rata waktu menunggu  dalam system (W) = 0,0309  
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7. Pilih menu Result -> Probability Summary  

  

8. Probabilitas adanya orang ke-6 (P6) = 0,0507  

9. Probabilitas adanya 2 orang yang mengantri dalam sistem pada penjualan tiket 

Proliga adalah P0 + P1 + P2 = 0,0957 + 0,2010 + 0,2110 = 0,5077  
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Latihan Soal  

1. Diketahui loket penjualan tiket kereta adalah 4 dengan tingkat pelayanan 33 

orang/jam mengikuti distribusi poisson. Serta diketahui juga tingkat 

kegunaannya 50%. Maka tentukan :  

a. Tingkat Kedatangan  

b. Proporsi tidak adanya pengantri dalam system  

c. Rata-rata banyaknya pengantri dalam antrian  

d. Rata-rata banyaknya pengantri dalam system  

e. Rata-rata waktu mengantri dalam antrian  

f. Rata-rata waktu mengantri dalam system  

g. Probabilitas adanya orang ke-10 

  

2. Diketahui penjualan tiket konser Mahalini secara langsung di venue, terdapat 

4 loket tempat penjualan tiket dengan tingkat pelayanannya 60 orang/jam 

mengikuti distribusi poisson. Serta diketahui juga tingkat kegunaannya 75%.  

Maka tentukan :  

a. Tingkat Kedatangan  

b. Proporsi tidak adanya pengantri dalam system  

c. Rata-rata banyaknya pengantri dalam antrian  

d. Rata-rata banyaknya pengantri dalam system  

e. Rata-rata waktu mengantri dalam antrian  

f. Rata-rata waktu mengantri dalam system  

g. Probabilitas adanya orang ke-9 
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3. Diketahui penjualan sepeda motor dilakukan secara langsung di showroom 

motor terdapat 3 sales yang melakukan penjualan dengan tingkat pelayanan 

50 orang/jam mengikuti distribusi poisson. Serta diketahui tingkat 

kegunaannya 80%. Maka tentukan :  

a. Tingkat Kegunaan  

b. Proporsi tidak adanya pengantri dalam system  

c. Rata-rata banyaknya pengantri dalam antrian  

d. Rata-rata banyaknya pengantri dalam system  

e. Rata-rata waktu mengantri dalam antrian  

f. Rata-rata waktu mengantri dalam system  

g. Probabilitas adanya orang ke-12 
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• Probabilitas adanya orang ke-1 
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BAB IV   

ANALISIS MARKOV  

  

Deskripsi Modul  

Analisis Markov diartikan sebagai suatu teknik ataupun metode matematika 

untuk meramalkan perubahan pada variabel-variabel tertentu berdasarkan 

pengetahuan dari perubahan sebelumnya. Dalam dunia usaha ataupun industri 

Analisis Markov digunakan untuk mengetahui kemungkinan perubahan yang 

terjadi pada usaha yang dilakukan yang pada akhirnya digunakan sebagai alat 

untuk membantu pengambilan keputusan. Pengambilan keputusan yang sering 

kali dibuat yaitu dalam hal hutang-piutang, keunggulan produk, pergantian merek, 

operasi mesin dan lain sebagainya.  

  

Tujuan Modul  

Setelah menyelesaikan praktikum pada modul ini, praktikan akan:  

1) Memahami konsep dasar mengenai Analisis Markov.  

2) Mampu menyusun probabilitas transisi maupun probabilitas tree dalam 

melakukan Analisis Markov.  

3) Mampu menyimpulkan hasil analisis yang dilakukan dari probabilitas yang 

diperoleh.  

4) Mampu menggunakan aplikasi software dalam Analisis Markov.  

  

Penjelasan Materi  

4.1 Pendahuluan  

Model Rantai Markov dikembangkan oleh seorang ahli Russia A.A. Markov 

pada tahun 1906. Pada umumnya Riset Operasional bertujuan untuk mengambil 

keputusan yang optimal atas suatu permasalahan. Namun, Analisis Markov 

digunakan untuk menghasilkan suatu informasi probabilistik yang dapat 

digunakan untuk membantu pengambilan keputusan. Dengan kata lain Teknik-
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teknik yang lain dalam Riset Operasional pada umumnya merupakan teknik  

optimisasi,  sedangkan  pada  Analisis  Markov  merupakan teknik deskriptif.   

Rantai Markov adalah suatu Teknik matematik yang biasa digunakan untuk 

melakukan pembuatan model bermacam-macam sistem dan proses bisnis. Teknik 

ini dapat digunakan untuk memperkirakan perubahan-perubahan yang akan terjadi 

di waktu yang akan datang dalam variabel-variabel dinamis atas dasar perubahan-

perubahan variabel tersebut di waktu lampau.  

 

4.2 Ciri-Ciri Proses Markov  

Probabilitas Transisi adalah perubahan dari satu status ke status yang lain 

pada periode (waktu) berikutnya dan merupakan suatu proses random yang 

dinyatakan dalam probabilitas.  

Untuk lebih jelasnya akan digunakan sebuah contoh kasus pada kendaraan 

umum. Dalam kasus ini terdapat dua buah state (kondisi/status) yaitu narik dan 

mogok. Jadi kendaraan umum tersebut akan selalu berada pada salah satu dari dua 

state tersebut, jika tidak narik maka mogok.  

Agar dapat digunakan dalam proses Markov dibutuhkan beberapa asumsi 

seperti berikut:  

1. Jika state kendaraan saat ini adalah narik maka hanya ada dua 

kemungkinan untuk kondisi waktu (hari) berikutnya yaitu narik kembali 

atau mogok. Sehingga jumlah probabilitas transisi pada setiap baris adalah 

satu.  

2. Probabilitas transisi itu tidak akan berubah untuk selamanya.  

3. Probabilitas transisi hanya tergantung pada status sekarang bukan status 

periode sebelumnya.  

  

4.3 Menyusun Probabilitas Transisi  

Untuk menunjukkan cara penyusunan probabilitas transisi, akan digunakan 

contoh kasus diatas dengan probabilitas-probabilitas sebagai berikut: 
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Status (saat ini) 
Banyaknya Mobil 

Hari I Hari II 

Narik 120 144 

Mogok 100 76 

Jumlah 220 220 

Tabel 3.1  

 

Hari I 
Hari II 

Jumlah 
Narik Mogok 

Narik 70 50 120 

Mogok 74 26 100 

Jumlah 144 76 220 

Tabel 3.2  

Dari tabel diatas dapat diperoleh Probabilitas Transisi sebagai berikut: 

Hari I 
Hari II 

Narik Mogok 

Narik 70/120 = 0,5833 50/120 = 0,4167 

Mogok 74/100 = 0,74 26/100 = 0,26 

Tabel 3.3  

  

4.4 Probabilitas Tree  

Probabilitas Tree merupakan cara yang mudah untuk menggambarkan 

sejumlah terbatas transisi dari suatu proses Markov. Agar lebih jelas kita masih 

akan mengambil contoh kasus di atas, semisal ingin diketahui:  

a. Probabilitas hari ke-3 narik, jika hari ke-1 narik.  

b. Probabilitas hari ke-3 mogok, jika hari ke-1 narik.   

c. Probabilitas hari ke-3 narik, jika hari ke-1 mogok.  

d. Probabilitas hari ke-3 mogok, jika hari ke-1 mogok.  

Maka kita akan buat Probabilitas Tree dari kasus di atas sebagai berikut :  
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Dari gambar 3.1 dan gambar 3.2 dapat kita jawab soal di atas, sehingga:  

Probabilitas hari ke-3 narik, jika hari ke-1 narik   

Probabilitas hari ke-3 mogok, jika hari ke-1 narik   

Probabilitas hari ke-3 narik, jika hari ke-1 Mogok   

Probabilitas hari ke-3 mogok, jika hari ke-1 Mogok   
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4.5 Pendekatan Matriks  

Ada kalanya kita harus mencari probabilitas pada periode yang sangat  besar, 

misalkan periode hari ke-9, ke-10 dan seterusnya, akan sangat menyulitkan dan 

membutuhkan media penyajian yang khusus jika kita menggunakan Probabilitas 

Tree. Permasalahan tersebut dapat diselesaikan dengan menggunakan metode 

Pendekatan Matriks Probabilitas.  

Adapun Matriks Probabilitas dari contoh kasus di atas adalah sebagai berikut:  

  

Probabilitas kendaraan narik pada periode ke-i jika pada periode ke-1 narik, 

dilambangkan dengan:  

Probabilitas Narik                                           Nn (i)      Periode ke-i  

 

 Status Awal Narik  

Probabilitas kendaraan mogok pada periode ke-3 jika pada periode ke-1 mogok, 

dilambangkan dengan:  

Probabilitas Mogok   Mm (3)  Periode ke-3                                

 
    Status Awal Mogok  

Jika kendaraan pada hari ke-1 narik maka berlaku probabilitas sebagai berikut: 

Nn(l) = 1 sedangkan Mm(l) = 0  

  

Jika probabilitas di atas disusun ke dalam vektor baris, maka kita dapatkan: (Nn(l) 

Mm(l)) = (1   0)  

  

Adapun rumus untuk mencari probabilitas periode berikutnya (i+1) adalah:   

      (Nn(i+1) Mn(i+1)) = (Nn(i) Mn(i)) x Matriks Probabilitas Transisi  
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Bila rumus di atas kita gunakan untuk mencari probibalitas hari ke-2, maka:  

  

      =   

      = (0,5833 0,4167)  

  

Terlihat bahwa hasilnya sama dengan yang diperoleh dengan menggunakan 

metode Probabilities Tree. Dengan menggunakan cara yang sama kita akan 

dapatkan status untuk periode-periode berikutnya sebagai berikut:  

(Nn(3) Mn(3)) = (0,6486  0,3514)  

(Nn(4) Mn(4)) = (0,6384  0,3616)  

(Nn(5) Mn(5)) = (0,6400  0,3400)  

(Nn(6) Mn(6)) = (0,6397  0,3603)  

(Nn(7) Mn(7)) = (0,6398  0,3602)  

(Nn(8) Mn(8)) = (0,6398  0,3602)  

  

Terlihat bahwa perubahan probabilitas semakin lama semakin mengecil 

sampai akhirnya tidak tampak adanya perubahan. Probabilitas tersebut tercapai 

mulai dari periode ke-7, dengan probabilitas status:  

(Nn(7) Mn(7)) = (0,6398 0,3602)  

Ini berarti pemilik kendaraan dapat menarik kesimpulan bahwa jika awalnya 

kendaraan berstatus narik, setelah beberapa periode di masa depan probabilitas 

narik adalah sebesar 0,6398 dan probabilitasnya mogok sebesar 0,3602.  

Untuk perhitungan probabilitas status hari pertama mogok dapat kita cari 

dengan metode yang sama dan akan kita dapatkan probabilitas yang akan sama 

untuk periode selanjutnya, mulai dari periode ke-8. Adapun probabilitas pada 

periode ke-8 adalah:  

(Nm(8) Mm(8)) = (0,6398 0,3602)  
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4.6 Probabilitas Steady State 

Dalam banyak kasus, proses Markov akan menuju pada Steady State 

(keseimbangan). Artinya setelah proses berjalan selama beberapa periode, 

probabilitas yang dihasilkan akan bernilai tetap, dan probabilitas ini dinamakan 

Probabilitas Steady State. Dari contoh diatas Probabilitas Steady Statenya adalah 

probabilitas narik sebesar 0,6398 dan probabilitas mogok sebesar 0,3602.  

Untuk mencari Probabilitas Steady State dari suatu Matriks Transisi, maka 

kita dapat menggunakan rumus:  

 

Karena Steady State akan menghasilkan probabilitas yang sama pada periode 

ke depan maka rumus tersebut akan berubah menjadi:  

 

Dari contoh kasus di atas dengan status hari ke-1 narik, maka kita dapatkan:  

  

Untuk mengurangi keruwetan, periode (i) dapat kita hilangkan, karena pada 

saat Steady State tercapai periode tidak akan mempengaruhi perhitungan.  

Sehingga perhitungan di atas akan menjadi:  

  

Dari perhitungan di atas akan menghasilkan persamaan berikut:  

 Nn  =  0,5833Nn  +  0,74Mn  .............................. (1)  

 Mn  =  0,4167Nn  +  0,26Mn  .............................. (2)  

Karena salah satu ciri proses markov adalah:   

Nn(i) + Mn(i)  = 1, maka:  

Nn + Mn         = 1 -> Mn = 1 – Nn  

 

  

  



 

62  

  

Dengan mensubstitusikan Mn = 1 – Nn ke persamaan (1) didapatkan:   

   

   

   

   

   

 

Lalu kita masukkan nilai Nn = 0,6398 ke dalam persamaan (2) didapatkan:   

   

   

   

  

4.7 Penggunaan Probabilitas Steady State  

Dari  contoh  kasus  kita  ketahui  bahwa  pemilik  kendaraan  memiliki  220 

kendaraan. Dengan menggunakan Probabilitas Steady State yang sudah kita 

dapatkan, pemilik  dapat mengharapkan  jumlah  kendaraan  setiap  harinya  narik  

atau  mogok sebanyak:  

Narik   : Nn x 220       = 0,6398 x 220 = 140,756 atau sebanyak 141 kendaraan  

Mogok : Mn x 220      = 0,3602 x 220 = 79,244 atau sebanyak 79 kendaraan  

Misalkan pemilik kurang puas dengan tingkat operasi yang ada dan ingin 

meningkatkannya, sehingga pemilik mengambil kebijakan untuk menggunakan 

suku cadang asli dalam setiap perawatan armada. Kebijakan ini membuat Matriks 

Probabilitas Transisi berubah menjadi:  

  

Artinya kebijakan ini membuat Probabilitas saat ini narik, lalu hari 

berikutnya mogok menurun dari 0,4 menjadi 0,3.  
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Probabilitas Steady State yang baru adalah  

  

Sehingga kita dapatkan persamaan berikut:  

Nn = 0,7Nn + 0,74Mn                         ................................... (1)  

Mn  = 0,3Nn + 0,26Mn       .................................. (2) 

Substitusikan Nn = 1 - Mn ke persamaan (2), sehingga kita dapatkan:  

Mn = 0,2885 dan Nn = 0,7116.  

Artinya setiap harinya pemilik dapat  mengharapkan kendaraan yang narik atau 

mogok sebanyak:  

Narik   : Nn x 220 = 0,7116 x 220 = 156,55 atau sebanyak 157 kendaraan  

Mogok : Mn x 220 = 0,2885 x 220 = 63,47 atau sebanyak 63 kendaraan  

Kebijakan tersebut menghasilkan kenaikan operasional dari 141 kendaraan 

perhari menjadi 157 kendaraan perhari. Dalam hal ini pemilik harus mengevaluasi 

kebijakan ini, apakah kenaikan pendapatan operasional dapat menutupi kenaikan 

biaya operasional karena kebijakan ini. Misalkan karena kebijakan ini terjadi 

kenaikan biaya perawatan kendaraan sebesar Rp 1.000.000,- setiap harinya. Jadi, 

bila kenaikan pendapatan operasional lebih besar dari Rp 1.000.000,- maka  

kebijakan  tersebut  layak  untuk dijalankan.  

Dari contoh ini menunjukkan bahwa Analisis Markov tidak memberikan 

solusi atau keputusan, namun analisis tersebut memberikan informasi yang dapat 

membantu pembuatan keputusan.  
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Contoh Soal  

Warteg Portugal (Porsi Tukang Galih) telah berdiri sejak 3 bulan yang lalu. 

Pemilik warteg ingin mengetahui perkembangan usahanya tersebut.  Berikut ini 

data-data  yang diperoleh pemilik warteg selama 2 bulan:  

Keterangan  Bulan 1  Bulan 2  

Untung  1.500  1.250  

Rugi  2.000  2.250  

Jumlah  3.500  3.500  

 

Dalam waktu 2 bulan terakhir terdapat perubahan terhadap keuntungan dan 

kerugian pada wartegnya. Untuk data lebih jelasnya, lihat tabel dibawah ini:  

Bulan 1 
Bulan 2 

Jumlah 
Untung Rugi 

Untung 500 1.000 1.500 

Rugi 750 1.250 2.000 

Jumlah 1.250 2.250 3.500 

  

Ditanya:  

a. Buatlah tabel probabilitas transisi dan tree!  

b. Tentukanlah probabilitas bulan ke-3 mengalami rugi, jika pada bulan ke-1 

untung!  

c. Tentukanlah probabilitas bulan ke-3 mengalami rugi, jika pada bulan ke-1 rugi!  

d. Tentukanlah probabilitas bulan ke-3 mengalami untung, jika pada bulan ke-1 

untung!  

e. Tentukanlah probabilitas bulan ke-3 mengalami untung, jika pada bulan ke-1 

rugi!  

f. Tentukan probabilitas pada kondisi Steady State!  

 

 



 

65  

  

Jawaban  

a. Tabel Probabilitas Transisi dan Tree.  

Bulan 1 
Bulan 2 

Untung Rugi 

Untung 500/1.500 = 0,3333 1.000/1.500 = 0,6667 

Rugi 750/2.000 = 0,375 1.250/2.000 = 0,625 

  

 
 

b. 0,2222 + 0,4167 = 0,6389  

c. 0,2500 + 0,3906 = 0,6406  

d. 0,1111 + 0,2500 = 0,3611  

e. 0,1250 + 0,2344 = 0,3594 
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f. Dalam menghitung Steady State dapat menggunakan cara seperti dibawah ini:   

X1   = 0,3333 (X1) + 0,375(1-X1)  

X1   = 0,3333 X1 + 0,375 – 0,375 X1  

X1   = – 0,0417 X1 + 0,375  

X1 + 0,0417 X1 = 0,375  

1, 0417 X1  = 0,375  

X1   = 0,36  

  

X2              = 1 – X1  

X2              = 1 – 0,36  

X2              = 0,64  

  

Penggunaan Software  

Langkah-langkah penerimaan dengan menggunakan Software WinQSB.  

1. Buka software WinQSB, pilih program MarKov Process.  

  
 

2. Pilih menu File -> New Problem untuk memulai.  
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3. Masukkan data:  

 Problem Title  = Markov  

Number of States = 2   

 

4. Isikan data sesuai dengan Tabel Probabilitas.  

  

5. Pilih menu Solve and Analyze -> Solve Steady State.  

  

6. Hasil akhir.  
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Latihan Soal  

1. Minang Café telah berdiri sejak 3 bulan yang lalu. Pemilik kafe ingin 

mengetahui perkembangan usahanya tersebut. Berikut adalah data-data yang 

diperoleh pemilik kafe selama 2 bulan: 

Keterangan Bulan 1 Bulan 2 

Untung 3.750 3.500 

Rugi 4.750 5.000 

Jumlah 8.500 8.500 

Dalam waktu 2 bulan terakhir terdapat perubahan terhadap keuntungan dan 

kerugian pada kafe tersebut. Untuk lebih jelasnya, lihat tabel dibawah ini: 

Bulan 1 
Bulan 2 

Jumlah 
Untung Rugi 

Untung 2.500 1.250 3.750 

Rugi 3.250 1.500 4.750 

Jumlah 5.750 2.750 8.500 

Ditanya : 

a. Buatlah probabilitas transisi dan tree! 

b. Tentukan probabilitas bulan ke-3 untung, jika pada bulan ke-1 rugi! 

c. Tentukan probabilitas bulan ke-3 rugi, jika pada bulan ke-1 rugi! 

d. Tentukan probabilitas bulan ke-3 untung, jika pada bulan ke-1 untung! 

e. Tentukan probabilitas bulan ke-3 rugi, jika pada bulan ke-1 untung! 

f. Tentukan probabilitas pada kondisi steady state! 
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2. Mark lee adalah seorang mahasiswa SNU, Ia ingin mengetahui perpustakaan 

mana saja yang paling banyak dikunjungi oleh mahasiswa SNU. Berikut 

adalah data yang diperoleh Angelina dalam waktu 2 bulan terakhir:  

Keterangan Bulan 1 Bulan 2 

Starfield Library 3.500 2.700 

Namsam Library 4.000 4.800 

Jumlah 7.500 7.500 

Dalam waktu 2 bulan terakhir terdapat peubahan pada kunjungan library 

yang dilakukan oleh mahasiswa SNU, Untuk lebih jelasnya, lihat tabel 

dibawah ini:  

Ditanya: 

a. Buatlah probabilitas transisi dan tree! 

b. Tentukan probabilitas bulan ke-3 Namsam Library, jika pada bulan ke-1 

Starfield Library 

c. Tentukan probabilitas bulan ke-3 Namsam Library, jika pada bulan ke-1 

Namsam Public Library! 

d. Tentukan probabilitas bulan ke-3 Starfield Library, jika pada bulan ke-1 

Starfield Library! 

e. Tentukan probabilitas bulan ke-3 Starfield Library, jika pada bulan ke-1 

Namsam Library! 

f. Tentukan probabilitas pada kondisi steady state! 

 

 

Bulan 1 
Bulan 2 

Jumlah 
Starfield Library Namsam  Library 

Starfield Library 500 3.000 3.500 

Namsam  Library 2.200 1.800 4.000 

Jumlah 2.700 4.800 7.500 
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3. Restoran Mie Gacoan telah berdiri sejak 3 tahun yang lalu. Sang Pemilik 

Restoran ingin mengetahui makanan apa saja yang paling banyak dibeli. 

Untuk itu, ia memperoleh data makanan mana yang sering dibeli oleh 

pelanggan. Berikut tabelnya: 

Keterangan Tahun 1 Tahun 2 

Gacoan 3.300 2.700 

Hompimpa  1.200 1.800 

Jumlah 4.500 4.500 

 

Dalam waktu 2 tahun terakhir terdapat perubahan pembelian pada 

Restorannya. Untuk data lebih jelasnya, lihat tabel dibawah ini: 

Tahun 1 
Tahun 2 

Jumlah 
Gacoan Hompimpa 

Gacoan 2.000 1.300 3.300 

Hompimpa 700 500 1.200 

Jumlah 2.700 1.800 4.500 

 

Ditanya:  

a. Buatlah probabilitas transisi dan tree!  

b. Tentukan probabilitas bulan ke-3 Gacoan, jika pada bulan ke-1 

Hompimpa!  

c. Tentukan probabilitas bulan ke-3 Hompimpa, jika pada bulan ke-1 

Hompimpa! 

d. Tentukan probabilitas bulan ke-3 Gacoan, jika pada bulan ke-1 Gacoan! 

e. Tentukan probabilitas bulan ke-3 Hompimpa, jika pada bulan ke-1 

Gacoan! 

f. Tentukan probabilitas pada kondisi steady state! 
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}Tentukan probabilitas pada kondisi steady state! 

Pada Bab 1, kita akan membahas mengenai TEORI ANTRIAN. TEORI 

ANTRIAN adalah teori-teori yang menyangkut studi matematis dari barisan 

atau barisan pengguna. Antrian ini terjadi apabila kebutuhan akan suatu 

pelayanan melebihi kapasitas yang tersedia untuk menyelenggarakan suatu 

pelayanan. Lalu pada Bab 2, kita akan membahas PROGRAM EVALUATION 

REVIEW TECHNIQUE atau yang biasa disebur PERT. PERT menjelaskan 

tentang pembuatan network yang berisi tentang pemahaman komponen-

komponen, analisanetwork dan hal yang perlu diperhatikan dalam analisa 

network, serta distribusi probabilitas beta sehingga dapat melakukan 

penjadwalan setiap kegiatan-kegiatan.  

Kemudian pada Bab 3, kita akan membahas tentang TEORI ANTRIAN 

DALAM PRAKTEK. Bab 3 ini merupakan lanjutan dari Bab 1, dalam Bab 3 ini 

membahas tentang Antrian yang menjelaskan tentang tujuan dasar model 

antrian, elemen-elemen pokok dalam antrian, macam-macam struktur antrian 

serta asumsi-asumsi yang digunakan dalam mengunakan teori antrian 

khususnya asumsi yang digunakan dalam model antrian jenis multi channel 

single phase. Selanjutnya pada Bab 4, kita akan membahas tentang ANALISIS 

MARKOV. ANALISIS MARKOV ini diartikan sebagai suatu teknik ataupun 

metode matematika untuk meramalkan perubahan pada variabel-variabel 

tertentu berdasarkan pengetahuan dari perubahan sebelumnya.  

Dalam Modul Riset Operasional 2 ini akan dijelaskan bagaimana cara 

melakukan penyelesaian kasus yang dapat diselesaikan menggunakan software. 

Software yang digunakan dalam modul ini adalah WINQSB 

 

 


